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This notice describes the functionalities of CYDAR which are common to all the modules. It details the 
installation procedure, gives an overview of CYDAR, and presents the main functionalities such as 
importing and exporting data, smoothing curves, displaying graphs. 

Figure 1 displays the modules available when a new project is open. The availability of each module 
depends on the login of the client. For each module, the specific functions are described in a separate 
document. The core analysis part is comprised of: 

• SCAL: Pc & pore size distribution, permeability, relative permeability, centrifuge capillary 
pressure and all Two-Phase Flow displacements.  

• Dispersion module. 

• Two-Phase Flow with chemical Enhanced Oil Recovery. 

Other modules are related to laboratory equipment with data acquisition boards, and are described in 
different user manuals. 

• Darcylog. 

• Darcypress. 

• PDOS. 

• Centri Video. 

• PMD 1608FS Data acquisition board. 

• LabCon and ResCon (two-phase core flow displacements). 

This notice refers to the version 8 distributed in 2017 in replacement of the previous version 6. 

 

 

Figure 1- CYDAR new project window. 
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Installation of CYDAR 

System requirements 
CYDAR is developed in Visual Basic (VB.net), an object oriented language that takes advantage of the 
Windows graphic environment. CYDAR runs on a Microsoft Windows operating system, and has been fully 
tested on Windows 7, 8, and 10. CYDAR does not require a powerful computer, and can be installed on a 
laptop or an older computer. CYDAR does not require access to the Internet. 

Numerical calculations such as the optimization loops are developed in FORTRAN using the powerful 
IMSL library. However, there is only one program to install, and the user has no direct contact with the 
various FORTRAN’s DLL or other graphical objects used by CYDAR. 

Installation of CYDAR 
Before installation, it is recommended to close all running applications. 

Insert the installation software on CYDAREX USB key or unzip and open the folder "CYDAR_installer" 
downloaded using the URL provided by CYDAREX. The folder contains other folders (tutorials, User 
Manuals, etc… To launch the installation, double-click on “setup.exe.” It is recommended to use the option 
“run as administrator”, using the mouse right click (even if you use an administrator account).  

The installer will start. Click the "install" button and follow on-screen instructions. There are several 
messages asking where to install CYDAR in your computer. Generally, you can use the proposed default 
values. 

After the installation is completed, click "finish". 

During the first utilization, a login and password will be required; contact CYDAREX if you do not have 
one. For registered clients, the login and password can be changed by opening the “about” menu in a blank 
project. 

Updating CYDAR 
Most updates can be installed by replacing the “cydar.exe” file by a newer version downloaded from 
CYDAREX website. The file to replace is usually located in C:\Program Files (x86)\CYDAREX\CYDAR\. 
Occasionally, a complete reinstallation of CYDAR might be required. In that case, it is recommended to 
first uninstall the software, and then perform a complete installation with the files downloaded from 
CYDAREX website. 

Uninstalling CYDAR 
To uninstall CYDAR, open “Add or Remove Programs” in Windows control panel. Then select CYDAR and 
click on “change/remove”. 

Silent Install of CYDAR 
To install CYDAR in silent mode for remote install, type the following command line:  

Navigate to the installation folder where the “setup.exe” file is. Then type:  setup.exe /s /v"/qb"  
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CYDAR Main Features 

All modules in CYDAR share the same features for data processing, graph and table displaying, and 
exporting results. This section describes the functions common to all modules and related to data handling 
and the graphic user interface.  

Opening and saving projects 
A project can be saved by choosing “save” or “save as” in the menu “file”. The extension ".cydx" is 
automatically added at the end of the project name. 

Existing projects are opened following the standard Windows procedure, by double-clicking on the file. 
When opening a file for the first time, Windows may ask the user to select the appropriate program to 
connect the extension “.cydx” or “.cyd” as a CYDAR file. Use the navigator to find CYDAR.exe in the 
program files folder. 

Files from previous version of CYDAR have a “.cyd” extension and can be opened with the latest version of 
CYDAR. Note that CYDAR version 8 and subsequent can only save as “.cydx”. These “.cydx” files cannot be 
opened with CYDAR version 6. 

Appearance 
The appearance of the software, with other options, can be changed in “Edit menu – Settings”. The Tool 
bar and the Status bar can be shown, and the Dark mode can be activated. 

 

Dark mode (left) vs. Light mode. 

 

AutoSave Settings 
By default, a project is saved every 10 min, but the delay can be 
reduced to 1 minute. In case of a crash during saving, the previous 
auto-saved project is always kept. Consequently, there are always 
two saved projects with names xxxx_1 and xxxx_2. The saved 
project files can be saved when closing CYDAR. The user will be 
prompt to save a project when closing the application. To access 
the AutoSave settings, select “Edit menu – Settings”. 

The directory in which the project is saved is the system 
temporary folder and cannot be modified.  The “Open” button will open the temporary folder in Windows 
Explorer (icon in the task bar, not on the desktop) 
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Importing Data 
Several methods are used to input data: 
• Entry boxes: values are typed and validated by pressing the 

return key or the tab key. 
• Data spreadsheets: “copy and paste” from Microsoft Excel or 

other applications can be used. 

CYDAR, with the module DAQ (Data Acquisition) can also monitor 
data during experiments by reading pressure, temperature, etc, 
via USB or RS232 connections (tailored applications like 
DARCYLOG™). 

 

 

 

 

 

Reading text files 
If required, CYDAR can open specific data files used by some equipment, such as the “.rpt” files provided 
by Autopore Mercury Injection version 1 device from Micromeritics Instrument Corporation. CYDAR can 
input data in the required format and units. An example is provided in the MICP tutorials. 

Importing a project from an Excel file (version 
2018) 
Available in version 2018, CYDAR offers an “import from Excel” function. This functionality is designed to 
import projects from Excel files. Ideally, many experiments are reported using the same Excel structure. 
For each Excel structure, a Template is made giving the position and type of each data in the data Excel 
file. The Template is then used to import all the similar data Excel files. 

Opening the Import window 

The Import function is only available from the home screen, when no files or projects are open. And the 
Import window is opened by clicking “Import Excel file…” from the File menu, or clicking Ctrl + I (Figure 
2). 

Useful Tips: 
Please avoid quotation mark “” when entering text data (such as reference of samples, 
comments). This symbol is used as a text separator and the text after the first quotation mark 
will be ignored. 
Shadowed text boxes are for display of results only and cannot be changed by the user. 

Useful Tips: 
If CYDAR quits unexpectedly, you might recover some of the past work by opening the 
temporary AutoSaved file. Do not re-open a saved file, as it will erase the AutoSaved file. 
Instead, open a new CYDAR file and press “open” in AutoSave settings, and look for the most 
recent .cyd file. 
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Figure 2: Opening the window to import from Excel can be done from the File menu,  

clicking on “Import Excel File…” 

 

The Import Window 

Three different selections are necessary in the “Import Excel file” window (Figure 3). 

 
Figure 3: The Import from Excel window. 

 

First step is to select the Excel file to import. This is done by clicking on the “Browse Excel file” button. 

The second step is to select the Template file corresponding to the experiment type. A Template file is an Excel 

file locating the different parameters (values, unit, type of data, etc…). See section below on how to create or 

modify the Template file. 

 

The optional third step is to select the Experiment Type (centrifuge, porous plate, one-fluid injected, etc…). This 

information can be done manually with the different combo boxes, or automatically by including these data in 

the Template file. 

 

Once all steps are performed, click the “Import and Save” button, and the Cydar file will be saved automatically 

(same location and same name than the Excel file, with a “.cydx” extension). Any Cydar file with the same name 

will be overwritten. 

A log file is displayed in the text box, reporting different steps and errors in importing the data. Saving the log 

file is optional (same location and same name than the Excel file, with a “.log” extension). The log file can be 

open with a text editor (such as Notepad). 

The CYDAR project can also be open automatically at the end of the import. 
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The Template file 

The Template file is an Excel file that contains the structure of the Excel data file that is imported (Figure 4). 

Typically, each experiment type will have its own template file. But all similar experiments can be imported 

with the same template. 

 

In the Template file (Figure 4), only columns C and D are read. Column C represents the position of the 

parameter described in column D. The position corresponds to the line (numeric) and column (alphabetic) 

position of a cell, such as cell position B:3. Positions and parameters can be adjusted depending on the Excel file 

being imported. For instance, from Figure 4, we can see that the Sample name (parameter GEN_Info.name) 

should be read from position B:2 in the Excel file. 

 

The sheet name with the data should be included as “sheet_data”. Two other sheets can be imported for 

comments and for profiles. If profiles are on the same data sheet, you can put the same name as data sheet. 

 

For each numerical value, the position of the value, and its unit are needed. If a unit cannot be read, refer to 

CYDAR and change the data in all Excel files with the correct spelling of the unit. Some units can be interpreted 

by the algorithm: for instance, “hours” is automatically read as “hour”; “seconds” and “second” as “s”. 

 

For data recordings, the position of the first point is needed; then all values in the subsequent lines are read. The 

X and Y values are read simultaneously. The acquisition is stopped when a non-numerical value (like an empty 

cell or a string that cannot be cast as a number) is found. 

For one-fluid injected (or single step centrifuge) experiments, only the rate (or the rotation speed) is given. Then 

the time for the experiment is determined from the last data points. 

 

The list of all CYDAR parameters can be found in the master template file. 

 

 

 
Figure 4: Example of a Template file. Column C represents the position in the Excel file 

 of the CYDAR data in column D. 

 

Importing Comments 

Comments in the Data Sheet can be imported by specifying the Excel cell to read, with the data reference 

GEN_Info.comments. In this case, only one cell is read, and added to the comments (Window Info in Cydar). 

 

Comments can also be added from a different Excel sheet. The name of the sheet needs to be entered in the 

Template, under the data reference “sheet_comments”. Then comments are added to the comment variable, and 

all cells under the reference cell are added to the comments. The process stops when two consecutive empty cells 

are found. 
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Importing Profiles 

Profiles in the Data Sheet can be from a different Excel sheet. The name of the sheet needs to be entered in the 

Template, under the data reference “sheet_profiles”. Refer to the master Excel Template file for how to organize 

the Template file. 

Errors during importing 

Several errors can happen during importing. If some data are not imported, refer to the log file for indication of 

the problem. 

The most common error is having the wrong sheet name in the Template. Then the data cannot be read. Another 

common error is not being able to interpret the unit. If a unit cannot be read, refer to CYDAR and change the 

data in all Excel files with the correct spelling of the unit. 

Loading data in CYDAR 
Most experimental data can be imported clicking on “Load 
Data”, “Data Points” or “Load/Fit Data” (depending on the 
module). This opens a spreadsheet (Figure 5). Lines can be 
removed or inserted through the menu “edit” or the right 
click menu: 

 

 

 

 

 

The left part of the spreadsheet has three frames: 
• Load raw data: the user can select the rows interval, 

data type, and units. 
• Noise filter: users can reduce noise by averaging data 

points over a specified number of points.  When 
calculating average, the number of points furthest away 
from the average (end-points) can be removed. When 
using filtering, only filtered data are kept as raw data. 

• File reduction: users can reduce the number of data 
points by removing data points when a variable 
remains constant. 

The specificities of the spreadsheets with the modules are 
described in the corresponding paragraphs.  

 
Figure 5 - a spreadsheet in CYDAR. Data are 
loaded by clicking on “Load Data”. 

Units 
All common units can be selected in combo boxes. Each data can have its own units: for instance, a sample 
can have its diameter expressed in inches and its length in cm. For calculation, all values are converted 
into the International Unit System, and results can be displayed in the selected unit. 
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For time units, the “adim (PoreVol)” unit is a dimensionless unit defined as:  

𝑡∗ =
𝑉𝑖𝑛𝑗𝑒𝑐𝑡𝑒𝑑(𝑡)

𝑉𝑝𝑜𝑟𝑒
, where t* is the dimensionless time, Vinjected(t) the total volume injected at 

time t, and Vpore the pore volume. The “adim (PoreVol)” will only appear if it can be 
calculated. The dimensionless time is available for most experiment types in the TPF 
and Dispersion modules. 

Note: If “adim (PoreVol)” is not available, data for the total volume for inlet sample need 
to be entered: once a simulation is run and the total volume for inlet sample has been calculated, right 
click on the total volume graph, and select “simulation to data points”.  Data points for the total inlet 
volume are now available, and “adim (PoreVol)” should be a time unit option. 

Format of numbers 
To change the number format in a box, place the cursor on the number and select the "format" menu (or 
press Ctrl+F). In the displayed window, enter the format following Microsoft standard. For example: 
• 0 for an integer (ex: 1343) 
• 0.00 for a decimal number with a given number of digits (ex: 

1343.45) 
• 0.00E+0 for scientific format with two digits after the decimal 

point and 1 digit in the exponent (ex: 1343.45E+0) 
• MM/dd/yy HH:mm:ss for date (ex: 08/25/10 12:02:36). See 

next section for additional information on date formats. 

Format of dates when loading data 
When loading time data in the date format (Figure 6), the data format must match the date format exactly. 
By default, the text box will display the date format of the operating system. If the date format of the data 
is different, the text box must be adjusted accordingly.  

 

 
 

 

 

 
Figure 6: Left: When selecting “date” for the time format, a text box displaying the date format appears. The date format 
must match the date data exactly. Right: When hovering over the date format label and text box, or when clicking the 
“help format” button, a summary of convention for date format appears. 
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Here are some conventions to import dates: 

 

To Display Use 

Year yyyy, yy (00 to 99), y (0 to 99) 
Month MM (01 to 12), M (1 to 12), MMM (Jan to Dec), MMMM (January to December) 
Day dd (01 to 31), d (1 to 31) 
Hour hh (00 to 12), HH (00 to 23) 
Hour as AM/PM tt (AM or PM), t (A or P) 
Minute mm (00 to 59), m (0 to 59) 
Second ss (00 to 59), s (0 to 59) 
Tenth of seconds f 
Hundredth of 
seconds 

ff 

Millisecond fff 

 

 

 

 

Here are some examples of date formats:  
“MM/dd/yyyy hh:mm:ss tt”; “d/M/yy HH:mm:ss”; “dd/MMM/yyyy HH:mm:ss:fff” 

Data editing 

 
Figure 7 - Edit points 
panel. 
 

The "edit points" button opens the following window (Figure 7). The editing 
panel presents the following functions: 

experimental points: selection of a given interval of data points. The total 
number of points is shown and the user can select the first and last points used 
to fit or interpolate experimental data. The corresponding abscissas are 
displayed in graph units.  

first and last points: end points coordinates in graph units. Both X and Y can 
be selected to be equal to the end points defined above or can be imposed. 

add/remove points: To add a point click on "add point" button, the shape 
cursor changes to "+", then hold down the shift key and left click. A cross 
symbol  will represent the added point (by default, the added points are 
visible).  

To remove a point, select "remove point(s)", hold down the shift then hover 
over the point to be removed.  

To remove an entire zone of points select "remove point(s)". Select the zone 
with the mouse (top left to bottom right, holding down the left button) hold 
down the control key then release the mouse button. All modifications can be 
cancelled using the "reset" button. 

move points: when the “move” button is clicked a data table is displayed. 
There are two ways to move a point: changing the values in the table or 
moving a point on the graph. On the graph, the mouse pointer will change to 
the hand cursor over movable points. To move a point left click on it and drag-
and-drop. To validate any move, the “calculate” button must be pushed. All 
moves can be cancelled using the "cancel" button. 

 

Useful tip: Please note that the case (capital or minuscule) is important for months 
(MM), minutes (mm), and hours (hh: 12 hrs system; HH: 24 hrs system). 
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Calculate button: to actualize any change, or to end move/add/remove tool. 

Remark: The “reset” in the add/remove section will erase all modifications. 

Undo-Redo: there is a five-step undo stack. “reset” will erase the stack. Cancelling the “move” tool set 
back the stack to its previous state. The undo/redo shortcuts are respectively “Ctrl+Z” and “Ctrl+Y”. 

Data smoothing 
Most experimental data are noisy and an efficient smoothing is needed for computation or history 
matching. Several analytical functions are available for smoothing, such as exponential or power law 
functions, but the most general and powerful tool is the spline functions. 

Principle of data smoothing 

Following a purpose of quality control, raw experimental data cannot be modified when they have been 
entered. However, the user can decide not to account for some experimental points that are obviously 
erroneous. The user may also decide to add points needed for numerical simulations, such as end-points 
in relative permeability. The operation of adding and removing points is called "editing" and is accessible 
in most modules by selecting the “Edit Points” button.  Figure 8 shows an example where two end-points 
are added, at x=0 and x=1, and three points removed from the raw data. The “edit points” function is 
detailed below. 

An analytical function is then calculated to represent a continuous form of the discrete experimental 
values. The default case is a linear fit, which is a linear interpolation between 2 consecutive data points, 
represented as a pink curve on Figure 8. This analytical function is displayed with a number of points (100 
by default) which can be changed in the “Graph edition window”. 

 

Figure 8 - The pink solid line represents the analytical fit with a linear interpolation between all raw data points. The 
solid black line represents a linear interpolation between consecutive points, with two end-points added and 3 data 
points removed. 
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Curve fitting 

CYDAR provides many analytical functions for smoothing and 
interpolation: "linear", “splines", "power", "modified Power", "Kr LET", 
"log(X^beta)", “Pc LET”, "bi-exponential", "biExp Multi-Step", 
"parabolic", "modified hyperbolic", "Splines Multi-Step", "Splines 
Interpolation", "Akima Interpolation", and "Hermite Interpolation" 
(Figure 9). 

These interpolation functions need to be used when optimizing Kr by 
points. 

 
Figure 9 - Various functions 
available for fitting. 

Interpolations (curve passes by all data points) 
• Linear: This corresponds to a linear interpolation between each data point. 
• Splines Interpolation: cubic spline interpolation with zero 2nd derivatives at end-points. 
• Akima Interpolation: cubic spline interpolation using Akima method to avoid wiggles in the 

interpolant. 
• Hermite Interpolation: Hermite cubic spline. 

Spline Fits (curve does not pass by all data points) 

A spline fit is the most powerful fitting tool available, providing several constraint controls (Figure 10). 
The user can specify the spline degree and the number of knots. The default value is 3 for both. Knots can 
be placed on a linear scale (default) or on a log scale. 

Briefly, a spline fit is a piecewise polynomial fit (of the specified degree). Data between each knot are 
fitted with a polynomial.  At each knot, there is continuity of the curve, and of the first derivative. 

 

 

Constraints can be imposed on the slope and curvature of the fit (“Constraints” frame in Figure 10). For 
example, Kr curves are assumed to be monotonous in a homogeneous sample. 

Two frames are used to impose the Y-coordinate of the end-points of an experimental or a given value, as 
well as its derivative. For instance, this function could be used to impose end-points of the Kr. 

The “tables” section allows the display of splines knots and coefficients in tables with a given number 
format. 

Useful tip: For a better fit, increase the number of knots, not the spline degree. 
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Figure 10 - Fitting with spline 
functions. 

 

 
Figure 11 - Fit of the data shown in Figure 8 using spline functions. Black line is 
fit with the constraints; blue circles are knots. 

 

 

Fit functions 

Other fits are available (Table 1), and the analytical equation is usually displayed in the fit window. Some 
functions are used for specific applications: 
• The power function is used for calculating the "Corey" fit of the relative permeabilities. 
• The “modified Corey”, or modified power law, is used to fit relative permeabilities, and corresponds to 

the equation: 

Y =Ymax(
a

2a
x2a +

b

a
xa +Hx)  with a = V-b-H and b = 2(1-H)-V+H. 

A more detailed description is given in CYDAR_SCAL user manual. 
• The Kr LET function is described in “A new versatile relative permeability correlation”, Lomeland et 

al., SCA, 2005, and is usually used for relative permeabilities. 
• The hyperbolic function is used for calculating the permeabilities from mercury injection by the 

Thomeer method. 
• The Pc LET function is described in: “A New Versatile Capillary Pressure  Correlation, Lomeland et 

al., SCA, 2008 , and is usually used for Pc curves. additional information is available in CYDAR_SCAL 
user manual. 

• "log(X^beta)" is described in the CYDAR_SCAL user manual, and is usually used for Pc curves. 
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a) Power law

 

b) Modified power law 

 

c) Parabolic 

 

d) Modified hyperbolic 

 

 

e) LogBeta 

 
 

f) bi-exponential 

 

g) Kr LET function 

 

Table 1 - some examples of the numerous fits available. 

Multi-step fits 

These fits can be used only in two-phase flow cases, when a specific variable called “block times” can be 
defined (see description of Two Phase Flow simulations). 

Multi-Step Splines (Figure 12) allows using the spline fit tool on each block time separately. The spline 
settings can be applied globally or per block. If “per block” is selected, the user must choose the blocks on 
the table by clicking on the left column. The corresponding area is highlighted on the graph with a yellow 
band as shown on Figure 13. 
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Figure 12 - Multi-step splines fit 

 

Figure 13 - Multi-Step bi-exponential fit. 

Multi-Step bi-exponential fit uses the bi-exponential fit (Figure 13) on the selected block times. 

Check boxes (numbered 1 to 5 on Figure 13): 
1. Open a table with the parameters allowing the user to copy and paste the parameters to another 

application. 
2. Select/unselect all five parameters on all block times: Yo, Yinf, Alpha, Tau1 and Tau2. 
3. Select/unselect a set of five parameters on one block time. 
4. Select/unselect one parameter on all block times. 
5. Select/unselect one parameter on one block time. 
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Buttons (Figure 13): 
• “calculate”: calculation of parameter. If no parameters are selected, the curve will be updated. 
• “undo calculation”: reset parameters to their values before last calculation. 
• “default”: Yo and Yinf from data points, Alpha = 0.5, Tau1 and Tau2 are the third of the block time 

interval. 
• “accept”: save the set of parameters. 
• “reset”: reset parameters to their values at the beginning of the fitting session. 

Graphs 
CYDAR uses two types of graphs: 
• "Edit Points" graphs are used for editing data points (either experimental or calculated) with a default 

yellow background. These graphs are automatically open when calling editing or fitting functions. 
• "XY-graphs" are for displaying input or output data; they have a default blue background. These 

graphs can be opened with the "view" menu of the main Window. 

Edit Points graph 

• Filtered data are called “raw data” in CYDAR (Figure 14). 
• Some corrections can be performed (for instance, calculation of offset and dead volume in the two 

phase flow module) leading to "corrected data". 
• As presented previously, the edit function is used to add, remove, or move points, and such editing 

leads to “edited points”. 
• The "edited points" are used to calculate fits, called "analytical function” in CYDAR. Those functions 

are then used for analytical calculations and interpolation. 
 

 
Figure 14 - Flow chart for the raw data. A yellow background is used for Edit functions and graphs. 

A blue background is used otherwise. 

XY Graph 

Experimental values are compared to simulation results using the XY graphs, with a blue background. This 
graph displays: 
• edited points, 
• analytical fit (points and line), 
• results of numerical simulations, 
• a backup of simulations, kept in memory for comparison. 

The two kinds of graphs, edit points and XY have the same following functions. 

Zooming part of a graph 

To scale up a part of graph, select the corresponding section with the mouse (top left to bottom right) 
holding down the left button (Figure 15a; result shown in Figure 15b). To undo, select a section of the 
graph with no data, holding down the left button from the bottom right to the top left (Figure 15b; result 
shown in Figure 15c). 
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Figure 15 - Zooming and un-zooming on a graph window by drawing a 
 rectangle upward (zooming) or downward (un-zooming). 

Moving the display zone 

On a graph window, the user can move the display zone by pointing on the graph, holding down the right 
button, and moving the pointer. To go back to the normal view, the procedure is the same than to unzoom. 

 
Figure 16 - Graph edition panel. 

Editing a graph 

Graph display parameters can be changed by double-clicking on the 
graph window or clicking on the axes. The Graph Edition panel 
(Figure 16) allows modification of most parameters, such as scale 
units, log scale, legends, symbols, colors, etc... 

Reticles 

A reticle (a vertical moving line) can be used to display 
corresponding points between different graphs, for instance pore 
radius and capillary pressure (Figure 17). 

To show the reticle, open "view" menu, and select "show all reticles". 
A green vertical line with a small box at the top appears on graphs. 
To move the reticle, click on one of the graph and press the arrow 
keys. A faster displacement is obtained by pressing simultaneously 
Shift and the arrows key. 

 

 



CYDAREX CYDAR Common Features User Manual   April 2021 

20/29 

 

 

Figure 17 - The reticle is the green vertical line showing the corresponding points between several graphs. 

Exporting results 

Graph 

From the “export” tab of the graph edition panel (Figure 16), graphs can be printed or copied directly into 
the clipboard as a metafile or bitmap format. This format allows a cut and paste into a Microsoft Word or 
Excel document. Graphs can also be saved as metafile, bitmap, or JPEG files. 

Simulation and analytical data 

For any graph, data points can be displayed in a table using the “Table” tab in the graph edition panel 
(Figure 16). Data can then be copied and pasted into another software such as Microsoft Excel. 

Reporting 

Project can be exported in a CSV (Comma-separeted values) file which can be directly opened with 
Microsoft Excel or a text editor. The extension .xls can be added to facilitate the opening of the file in Excel.  
The report summarizes all data: 
• General information: date, client name, operator, etc… 
• Sample data: length, diameter, etc… 
• Experiment data: type, set up, etc… 
• Fluids properties: viscosity, density, etc… 
• Simulation parameters: accuracy, mesh parameters, etc… 
• Experimental raw data, edited data, analytical function, simulation data 
• Tow-phase flow data: 
• Analytical functions used for capillary pressure and relative permeabilities. 
• Block time values 
• Permeability data: 
• Klinkenberg correlations parameters 
• Pc and Pore size distribution data 

 

 
Useful tip: All data are exported in the same unit as their corresponding graph. 
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The report provides an easy editing format which, used with templates, allows automated and complex 
layout of all results. Figure 18 shows a part of a report for a steady-state imbibition. Figure 19 shows an 
example of layout using Microsoft Excel template with company logo, graphics, etc. 

Pre-formatted reports can be available with the company logo and simple changes in the report are 
included in the CYDAR. 

 

Figure 18 - Part of a two-phase flow report. 

 

Figure 19 - Example of a more complex layout using a template. 
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Copying a graph or a frame 

Select the graph or the frame and press Ctrl+W to copy in the clipboard or use “copy active window” in the 
edit menu. Then copy in Microsoft Word, Excel, or any other software. 
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Curve Fitting Tool 

The Curve Fitting tool, accessed through CYDAR main window, is an independent module that gives access 
to CYDAR fitting functions, data manipulation, and allows several calculations. 

 

 
Figure 20 - Curve Fitting 

tools main window.  
Figure 21 - View 
window to display 
the results of 
calculation. 

“information” opens the information window, common 
to all modules (sample, operator, client …). 

“Load Data (Ascii)” opens a window for data loading, 
editing, or fitting (Figure 20). 

“modify data points” allows modification of data. 

“edit points” allows data editing (Figure 7). 

Once data are entered, they need to be fitted with the 
“curve fitting” tool, describe on pg. 13. 

Once data are entered and fitted, the “View” menu gives 
access to additional graphs (Figure 21). 

 

 
  



CYDAREX CYDAR Common Features User Manual   April 2021 

24/29 

Appendices 

Numerical methods 
Depending on the modules, numerical calculations are based either on explicit or implicit methods. 

Explicit methods calculate the state of a system at a later time from the state of the system at the current 
time, while implicit methods find a solution by solving an equation involving both the current state of the 
system and the later one. 

Mathematically, if Y(t) is the current system state and we want to find Y(t + Δt) at the later time, t+ Δt , (Δt 
is a small time step), then, for an explicit method: 

𝑌(𝑡 + Δ𝑡) = 𝐹(𝑌(𝑡)) 

while for an implicit method one solves an equation: 

𝐺(𝑌(𝑡), 𝑌(𝑡 + Δ𝑡)) = 0 

Newton-Raphson and Euler are two examples of powerful methods used to solve implicit schemes in 
CYDAR. 

Newton-Raphson method: 

Flow equation can be written as 𝐅(𝑡) = 0 and then the system can be solved with the Newton-Raphson 
iterative method. 

In one dimension, the Newton-Raphson Algorithm to solve 𝑓(𝑥) = 0 is: 
• First guess: 𝑥0, 𝑘 = 0 
• Newton-Raphson loop until ‖𝑥𝑘+1 − 𝑥𝑘‖ < 𝜀: 

• Solve 
∂𝑓(𝑥𝑘)

∂𝑥
  Δ𝑥 = −𝑓(𝑥𝑘) 

• 𝑥𝑘+1 = 𝑥𝑘 + Δ𝑥 
• 𝑘: = 𝑘 + 1 

The solution is the last 𝑥𝑘+1. 

Remark: 

It exists different convergence criteria like the relative error ‖𝑥𝑘+1 − 𝑥𝑘‖ < 𝜀 𝑥𝑘  or on the residual as 
follow 𝑓(𝑥𝑘) = 𝜀 𝑓(𝑥0). The choice of the difference, ‖𝑥𝑘+1 − 𝑥𝑘‖ < 𝜀, as exit test is based on empirical 
work done over several boundary, initial and experimental conditions. 

Euler implicit: 

The Euler implicit method is also known as the backward Euler method. Let’s consider the following 
equation: 

∂𝑦(𝑡)

∂𝑡
= 𝑓(𝑦(𝑡)) 

The purpose is then to use the finite difference: 

∂𝑦

∂𝑡
=

(𝑦𝑛+1 − 𝑦𝑛)

𝛿𝑡
 

and to solve iteratively, with a Newton-Raphson method for instance: 

𝑦𝑛+1 = 𝑦𝑛 + 𝛿𝑡 𝑓(𝑦𝑛+1) 

Transient permeability module: 

The flow equation is 
∂𝜑 𝜌

∂𝑡
+ ∇(𝜌 𝐔) = 0 and can be written in term of pressure in one dimension as follow 

on each grid: 
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𝜑(𝑃) 𝑐(𝑃)
∂𝑃

∂𝑡
+

∂𝜑(𝑃)

∂𝑡
+ 𝑈(𝑃) 𝑐(𝑃)

∂𝑃

∂𝑥
+

∂𝑈(𝑃)

∂𝑥
= 0    ⇔     𝑓(𝑡, 𝑥) = 0 

Because this is solved on each grid, we have a non linear system to solve 𝐹 = 0 Then P and F are vector of 

length n (n being the number of grids): 𝑃 = (𝑃1 ⋯ 𝑃𝑖 ⋯ 𝑃𝑛) and 𝐹 = (𝐹1 ⋯ 𝐹𝑖 ⋯ 𝐹𝑛). The 

Newton-Raphson algorithm is the same as above with the following system to solve iteratively: 

𝑃𝑘+1 = 𝑃𝑘 − 𝐽−1𝑘
 𝐹𝑘 

With 𝐽−1 the inverse of the Jacobian matrix of 𝐹 in accordance with 𝑃. 

Two-phase flow module: 

CYDAR has two fully implicit solvers implemented: uncompressible and compressible. 

For Two-Phase Flow simulations, “Fully implicit” means that the saturation and the pressure are solved 
both implicitly. 

The well-known “IMPES” method (Implicit Pressure Explicitly Saturation) has been removed in the recent 
version of CYDAR, due to its lack of accuracy. 
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Right click menus 
WHERE ACTION  

Input tables 

 

Spreadsheet  

removing, inserting lines  

 

Optimization per points: 

Kr and Pc tables. 
Formatting numbers by column 

 

Optimization per points: 

Kr and Pc graphs. 

Undoing all moves since the 
beginning of the optimization. 

 

XY Graphs 

Loading simulation curve as 
data points (not available for 
graphs with several variables 
displayed like “Pc centri”, Kr, 
etc.). 

Opening data tables. 

Activating Full window display 

Axes auto scale 
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Shortcuts 
SHORTCUTS WHERE ACTION 

Ctrl+F 
Text boxes 

Input tables and spreadsheet 
Formatting a number or a column in a table. 

Ctrl+Z 
Optimization per points: 

Kr and Pc tables and graphs. 

undo the last move only, if no other action 
has been done 

Ctrl+Z Data editing five steps undo stack 

Ctrl+Y 
Optimization per points: 

Kr and Pc tables and graphs. 

Redo the last undo, if no other action has 
been done 

Ctrl+Y Data editing five steps undo stack 

Ctrl+W Any CYDAR’s windows Copy to the clipboard 

Ctrl + click on   Graph Windows Close all graph windows 

Shift + click On data point in Graph Shows a window with X-Y values of point 

Troubleshooting 
Here is an overview of know issues and solutions. 

Issues when copy-pasting with Excel 

When copy-pasting between CYDAR and Excel, numbers are not transferred properly. This is usually due 
to a mismatch between CYDAR number separator (the comma or dot used to denote decimals) and Excel’s. 

CYDAR uses the number separator set by the operating system.  CYDAR can work with either comma or 
dot. Problems can occur when Excel is set to a different separator than the operating system. 

To solve this problem, open “Excel options/Advanced” in Excel, and make sure that “Use system 
separators” is checked (Figure 22). 

 
Figure 22- Excel option to set decimal separator. 
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Problems with the Installation 

The installation software cannot be launch 

If Windows is set to use a Latin alphabet, but the installation software path contents letters from a 
different alphabet (Hebrew, Arabic, Cyrillic), the installation program might not be able to access the 
installation files. 

If the installation software cannot be launch, it is recommended to use only Latin letters in its path. 

If the user name contents non-Latin letters, you can create a temporary user, and run the installation 
software from the temporary user.  Once installed, CYDAR™ should run without problems even if non-
Latin letters are present. 

Text on CYDAR™ windows is impossible to read 

It may happen that CYDAR™ looks as shown on Figure 23. 

 
Figure 23: Problem with 
the size of the font. 

This problem is due to the fact that the font in each object is too large 
compared to the object, and the problem can have several origins: 

In Windows settings, in “Display properties/Settings/Advanced”, make sure 
that the DPI setting is set at a minimum of 96 DPI. CYDAR™ is not designed to 
run with a DPI below 96. 

Under some circumstances, Windows uses a different font for MS sans serif, 
and this font is slightly larger. The original font can be reset using the registry 
editor: 
click on the Windows logo at the bottom left of the screen (formerly the "Start" 
button), and in the tab "Search for programs and files", type: “regedit”. This 
opens the registry editor. 
In the registry editor, navigate to: 
“HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion\Fonts\MS Sans Serif 8,10,12,14,18,24.” 
By double-clicking on the font MS Sans Serif, the value data should read: 
“SSERIFF.FON” 
If it does, change it to: “SSERIFE.FON” – Note that there is one letter change: a 
F becoming a E. 
Press okay, and close the Registry Editor.  You need to restart your computer 
for the change to take effect. 

 

The main window appears too small 

  
 

Figure 24 - Main window not showing all the display (left) and normal window (right) 
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When opening a new project, the main window (and other windows) is too small (Figure 24). The 
problem is related to a 125% zoom (or larger) imposed for the display in Windows by the user or put by 
default. There is a conflict between the zoom defined at two different places in Windows. 

The problem is solved in 2 steps: 

1. In the configuration panel of Windows, open "display", and customized size. Replace 125% by 
100%. Then log-out from your session of restart the computer 

2. Right click on the screen with the mouse. Open "display settings". Remove the automatic rescaling 
and impose 125% 

With 100% on the configuration and 125% in the screen settings, the zoom is really 125% and there 
should not be any problem with CYDAR (Figure 25). 

 

 

Figure 25 – The control panel must be at 100% (right picture) and the Desktop as the chosen zoom (left picture) 
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